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Assessments



Assessment Reporting in HDW

Users can report on the content of Announcement Questionnaires and Assessment Packages in HDW, as well
as applicant scores and responses.

g Assessment Package

& Vacancy 10110708 A Announcement 2t  Applicant Overview

USAJCBS Job Title Announcement Type Status

Test Position G5-0343-9 DE-ST Removed
JSAJO nouncement Title n-Series-Crade Assessment D

Annocuncement Information Announcement Location Announcement Questionn Announcement Text
Human Resources Specialist GS-0201-11/12 10746
Expand Questionnaire

+ Assessment Questionnaire (12 Items)

& Vacancy 10002730 I Assessment Package 4  Announcement 2 Applicant Overview @ Certificates & Reviews ' Assessment:2730

Announcement Questionnaire

Select All
+ Biographic Information (13 items)

Thank you for your interest in a Human Resources (HR) Specialist (Recruitment 2nd Placement) position with the Federal government.
+ Eligibilities (10 items)
+ 1. Select the one statement that best describes the education and/or experience that you possess that demonstrates your ability to perform HR Specialist (Recruitment and Placement) work at the GS-11 level or 2

equivalent pay band in the Federal service. — Preferences (3 items)

+
]

. Do you have one year of specialized experience (equivalent to at least the GS-11 level or pay band in the Federal service) that includes performing the following duties: interpreting and applying complex
personnel laws, requlations, practices, and procedures relating to recruitment and placement activities; providing HR consultant/advisory services and products in the areas of staffing, recruitment, and placement — Willingness to Relocate =
to managers, supervisors, employees, and applicants; analyzing trends and forecasting changes in workForce requirements that may impact Future recruitment needs of an organization; developing or medifying
organization-wide policy relating to recruitment and placement procedures; conducting job analysis, reviewing applicant qualifications, and referring eligible candidates for employment consideration; analyzing Are you willing to relocate For this position without relocation expenses offered?

and resolving uncommon recruitment and placement issues; and participating as a lead/senior consultant at meetings/conferences regarding workforce initiatives and strategies?

@ Radio Buttons - Yes/No

+ 3. Recommend zlternative course of action to accommodate the recruitment/staffing needs of a customer. *

= willingness to undergo security check
+ 4. Inform clients or managers about regulatory or policy changes, as well as the potential impact of these changes on their current procedures or programs. * 9 9 y

Are you willing to undergo a security check for this position?
+ 5. Consult with client managers and/or subject matter experts to discuss strategies for a recruitment or staffing initiative. *

@ Radio Buttons - Yes/No
+ 6. Provide technical assistance to staff in resolving complex work task.
+ 7. Provide authoritative advice to managers and staff members within the organization regarding the development of policies, standards, and procedures concerning physical and personnel security areas or * = Secret clearance |
activities.

Are you willing to obtain a secret clearance?

@ Radio Buttons - Yes/No




Assessment Package Data

The Assessment Packages area of HDW contains data on the characteristics of the Assessment Package,
content of the assessments, and assessment scoring information.

~ B0 Hiring Data Warehouse
w B Prasentation View
» [J Announcements
» [ Applicants
» [ Applications
~ 5 Assessment Packages

« B Assessment Information Data from this area of HDW will return regardless of whether an
e applicant has started or completed the assessment.

> B Assessment Flags

> [ Assessment Instructions

> FR Assessment Items

3 R Assessment Methods

> [ Asseszment Responses

> [ Questionnaire Assessment Methods
« [ Assessment Package Information

» [ Assessment Package

> ff Assessment Package Categories Assessment Package ID - Azsessment Package Complete?  Assessment Package Status  Assessment Package Rating Combination  Assessment ID Assessment Mame  Assessment Type

> B Assessment Package Job Analysis Outputs 10865 ez Complete 0201-1 10746 2730 Questionnaire

> B Assessment Package Job Analysis Sources 0201-12 10748 2730 Cuestionnaire

> [ Assessment Package Rating Combinations
~ B Assessment Scoring Information

» FH Assessment Competancies

> B Assessment Competsncy Rating Combinations

» B Assessment Item Scoring

> FR Assessment Plan

> FH Assessment Rating Settings

> FH Assessment Screen-0uts

> F Hurdle Criteria
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In the Vacancies area of HDW, data on several flags can be reported on to easily identify whether an
assessment type was used to evaluate applicants and whether assessments are delivered in multiple hurdles.

ring Data Warehouse
Presentation View
[ Announcements
[ Applicants

'*\‘

= Vacancies

Assessment-Related Flags

» [J Incomplete Application Information

» [ JOA Review Information
~ B3 Vacancy Information
» E Appointing Authorities
w [ Vacancy

abc ACWA Position?

’\'

These query items return ‘Yes' if one or more
assessments of that type was used, and ‘No’ if not.

S

sbe Multiple Hurdles?

sbe Mo Assessment Used?

S

abc Questionnairs Used?

abc SME

valuation Used?

Pl

abc USA Hire Used?

abc Manual Assessment Used?




Assessment Scores and Responses

When reporting on applicant assessment scores and responses to assessment items, use data from the
Applications area of HDW.

goo
[=]=[=]

o Hiring Data Warehouse

v & Presentation View
» [ Announcemsents
» [ Applicants

~ 5 Applications . .
o Anmouncement Questionnaire This area of HDW will only return data for assessments an

> [ Application Information applicant has completed.
» [ Application Metrics
v 5 Assessments
> B Application Assessment Items and Responses
A Application Assessment Ratings
M Application Battery Ratings

A Application Competency Ratings

R

A Application Hurdle Ratings

Application Assessment Ratings provides assessment-level applicant scores. Application Assessment Items and
Responses provides the content of the item and the response provided by the applicant. Characteristics of the
assessment (e.g., assessment name) are also available.



Assessment Scores and Responses

Data from the Assessment Packages and Applications areas should not be included in the same query
because data will repeat.

Assessment | Assessment Assessment ltem Text Application  Application = Application Application Assessment ltem Text
Mame Item Mumber  Assessment Assessment
MNumber Mame Item
Number

ATZFE- 2730 1

Select the one statement that best describes the education andfor experience that you
possess that demonstrates your ability to perform HR Specialist (Recruitment and
Flacement) work at the GS-11 level or equivalent pay band in the Federal service

Select the one statement
that best describes the
education andfor experience
that you possess that
demonstrates vour ability to
perform HR Specialist
(Recruitment and
Flacement) work at the GS-
11 level or equivalent pay
band in the Federal service.

2730 1

10 Conduct special studies in areas reguiring added management attention

Select the one statement ATZFE-
that best describes the P&P7
education andfor experience

that you possess that
demonstrates your ability to
perform HR Specialist
(Recruitment and
Flacement) work at the GS-
11 level or equivalent pay
hand in the Federal service.

Select the one statement ATZFE-
that best describes the P&P7
education andfor experience

that you possess that
demonstrates your ability fo
perform HR Specialist
(Recruitment and
Placement) work at the GS-
11 level or equivalent pay
hand in the Federal service,

2730

Prepare and conduct special studies when needed to determine impact on the AF or

2730 11
identify program areas needing special emphasis

2730




SME Evaluations



Subject Matter Expert (SME) Review

Characteristics

When reporting on the characteristics of SME reviews, use data from the Applications area of HDW.

~ B3 Hiring Data Warehouse
~ B Presentation View
> [ Announcemeants
> [J Applicants
w B Applications
» [ Announcement Questionnaire
> [ Application Information
> [ Application Metrics
» [ Assessmenis
v 3 SME Review Information
3 Bl SME Reviewsrs
~ A SME Reviews
(0 SME Reaview
(0 SME Reaview
(D SME Review Last Updated Date/Time
abc SME Raview Name
abc SME Review Owner
(0 SME Reaview
abs SME Ravi
abc SME Review Returned By Name
(© SME Raview
(0 SME Reaview

abe SME Raview

Creation Date/Time

Due Date

Recall Date/Time

w Recall Reason

Returned Date/Time
Sent Date/Time

Status

SME Review Name SME Review Owner

SME Review - Supervisory Attorney Advisor Arizaga, Sara
SME Review Hyman, Kana
Economist G5-15 SME Review Pollacci, Lori

SME Review, G5-0160-14, FHR-113854
SME Review

Structured Resume Review (E.O compliant)

Frasca, John
Arizaga, Sara

Rawson, Chance

This query subject provides information about the SME reviews

SME Review Status
HR Recalled
Active
Active
HR Recalled
Mot Sent

Returned

themselves, including the status of the reviews.

4  Announcement

E Assessment Package

= Vacancy 10060037 At Applicant Overview & Certificates

Review Name Review Type Status

SME Eval Subject Matter Expert (SME) Auto Recalled

Review Information Review Assignments

Review Information

9/30/2022

Evaluations

Review Name: *
SME Eval

Assessment: *
owner: *
iaria Ahmad

Due Date: *

9/30/2022 =

SME Review Recall Date/Time SME Review Creation Date/Time SME Review Due Date SME Review Last Updated Date/Time

08/21/2023 04:28:26.267 PM 08/18/2023 09:30:09.913 AM 08/22/2023 08/21/2023 04:28:26.493 PM
09/07/2023 03:45:36.390 PM 10/18/2023 10/12/2023 03:22:01.637 PM
10/10/2023 03:53:46.580 PM 10/17/2023 10/10/2023 04:31:32.5393 PM
10/11/2023 02:08:08.683 PM 09/29/2023 12:01:49.753 PM 10/20/2023 10/11/2023 02:08:09.103 PM
08/28/2023 02:47:38.070 PM 08/31/2023 08/28/2023 02:47:38.070 PM

08/21/2023 03:01:32.373 PM 09/14/2023 09/22/2023 08:48:25.187 AM



Subject Matter Expert (SME) Reviewer Information

When reporting on the characteristics of the SME reviewers, use data from the Applications area of HDW.

~ 25 Hiring Data Warehouse
~ B Prasentation View
» [ Announcements
» [ Applicants
w B3 Applications
» [ Annocuncement Questionnaire
> [O Application Information
> [ Application Metrics
» [ Asssssments
~ = SME Review Information
~ [ SME Reviewsrs
ab: SME Reviewsr Emaill
abe SME Reviewer Inactive?
abe SME Reviewsr Name
ab: SME Reviewer Phone Number
abc SME Reviewsr Tizbreaker Only?

abe SME Raviewsr Title

& Vacancy 10060037 i Assessment Package A&  Announcement A& Applicant Overview

This query subject provides information about the reviewers who
are functioning as SMEs, and not about the reviews themselves.

SME Reviewer Title
Hiring Manager User
Hiring Manager User

Hiring Manager User, Human Resources User

Hiring Manager User, Human Resources User, Onboarding User

Hiring Manager User

Review Name

Review Type
SME Eval Subject Matter Expert (SME)

Review Information Review Assignments Evaluations

Review Assianments

Reviewer Name

Status

Auto Recalled

Automated Abernathy
Automated Abney

Leviticus Flory-Hefelump

SME Reviewer Tiebreaker Only? SME Reviewer Inactive?

No
No
Yes
No
No

No
No
Yes
Yes
No

©  corticner i Fedmsees

9/30/2022
Phone Email
555-555-5555 automatedstaffingtest+5@amail.com
555-555-5555 automatedstaffingtest+6@gmail.com
(202) 422-9042 levi.flory@opm.gov

Tiebreaker Only B Inactive
[m] [m]
O O

[m] [m]



Subject Matter Expert (SME) Evaluation Content

When reporting on the content of SME evaluations used for an application, use data from the Assessment
Packages within the HDW.

v &5 Hiring Data Warehouse
v T Presentation View

> 3 Announcements

igippt?catﬁts To check if an SME Evaluation requires justification and to see how
pplications H 1
b Assssement Packages many SME evaluators are required per applicant, use the SME
« B9 Assessment Information Evaluation Justification Required and SME Evaluators query items
> B Assessment located in Assessment Packages > Assessment Information >
> B Assessment Flags Assessment

> B Assessment Instructions

v g Assessment Items

abc Assessment Ttem Header SME Evaluation Justification Required

# Assessment Item ID For All Responses
abc Assessment Item Number Only for Disqualifying Responses
anc Assessment Item Rating Scale For All Responses

abc Assessment Item Required?
abc Assessment Item Response Type SME Evaluators
abc Assessment Item Text

abc Assessment Item Used for Screen-Out?

abe Linked Competency

This query subject previously only included questionnaire assessment data but has been expanded to include
SME-related information.



Subject Matter Expert (SME) Evaluation

Outcomes

When reporting on SME evaluation outcomes, use data from the Applications area of HDW.

goo

A [=]=[=]

Hiring Data Warehouse
~ 75 Prasentation View

» [ Announcements
» [ Applicants

v 5 Applications This area of HDW will only return data for applicant SME evaluations

that evaluators have completed and come to consensus on.

» [ Announcement Questionnairs
» [ Application Information
» [ Application Metrics
v 5 Assessments
> B Application Assessment Items and Responses
> B Application Assessment Ratings
> B Application Battery Ratings
> B Application Competency Ratings

> B Application Hurdle Ratings

For SME evaluations, the scores and responses reflected in these query items show the final consensus rating
by the evaluators, and not responses given by the applicant. This is different than when pulling data on other
types of assessments which does provide applicant responses.



SME - Additional Information

For more information on SME evaluations and reviews, visit the Structured Resume Review area of the
Resources page within the USA Staffing Resources Center.

USA Staffing Resource Center

Welcome to the USA Staffing Resource Center! This site provides important information and resources to support your agency's implementation and use of USA Staffing. We have designed this site with agency leaders, Advisory Board Members, and implementation teams in

RESOURCES REPORTING & ANALYTICS USA HIRE PRODUCTION ENVIRONMENT

SYSTEM FEATURES INTERCONNECTIONS USAJOBS STAGE ENVIRONMENT

- USA Staffing
ol Training
COMMUNICATIONS RELEASE CALENDAR USER TRAINING TRAINING ENVIRONMENT
Resources
Structured Resume Review % Candidate Inventory

Candidate Inventory Pre-Implementation Guide (May 20232) B

USA Staffing Candidate Inventory Business Process Rules Example (October 2023) B
Candidate Inventory PowerPoint Presentation {October 2023) B

Marketing Flyer (! 2023)0

Candidate Inventor . Talent Pools (May 2023) [

Customer Sprint Review - Candidate Inventory - June 1, 2023 (Passcode: G6j"~3CeX) &
Candidate Inventory Frequently Asked Questions (FAQs) - June 2023 10

Memo to HR Directors Launching Structured Resume Review Training (Febr

Registration Instructions for Structured Resume Review Training (Septemb.
Structured Resume Revi larketing Flyer (September 2023) B
Structured Resume R Powerpoint Presentation (September 2023) B
Customer Sprint Review - Structured Resume Review - April &, 2023 (Passcode: 2KYASHH) &
Structured Resume Revi
SME Evaluation Assessment Methods (September 2023) B
SME Evaluation HR User Guide (September 2023) B

SME Review Assignment User Guide (April 2023) Bl

w Frequently Asked Questions (September 2023) BI

Direct link to the Resources page: https://help.usastaffing.gov/ResourceCenter/index.php/Resources



https://help.usastaffing.gov/ResourceCenter/index.php/Resources

Competency Ratings



Competency Ratings

When reporting on applicant competency ratings within an assessment, use data from the Applications
area of HDW.

goo

A [=]=[=]

Hiring Data Warehouse
~ 75 Prasentation View

» [ Announcaments
» [ Applicants

~ 5 Applications

» [ Announcement Queastionnaire

This area of HDW will return competency level scores for assessments

> [ Application Information . . . .
an applicant has completed by rating combination.

» [ Application Metrics

v 5 Assessments
> B Application Assessment Items and Responses
> B Application Assessment Ratings

> B Application Battery Ratings

» B Application Competency Ratings

> B Application Hurdle Ratings

Application Competency Ratings can be used in combination with data from other areas within HDW,
following the same guidance provided for Applications data in the HDW Data Relationships Job Aid.



Competency Ratings

Vacancy
Number

10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419
10052419

Application
Number

AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW
AQWQV-BIRW

Application Assessment

Name
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test
Program analyst test

Program analyst test

0343
0343
0343
0343
0343
0343
0343
0343
0343
0343
0343
0343
0343
0343
0343
0343

Application Competency Rating

Application Competency Rating Application Competency

Series Grade Name

il Arithmetic

il Computer Skills

il Decision Making

11 Financial Management
12 Arithmetic

12 Computer Skills

12 Decision Making

12 Financial Management
13 Arithmetic

13 Computer Skills

13 Decision Making

13 Financial Management
9 Arithmetic

9 Computer Skills

9 Decision Making

9 Financial Management

FENEE S L T TR — T R = = = = = = = = =

Application Competency Raw
Score

When using, always include (at a minimum):

Application Number

Application Assessment Name
Application Competency Rating Grade
Application Competency Rating Series
Application Competency Name

B T TR R e e R - - K. - U T - S R =

Application Competency Maximum Raw
Score



Competency Ratings

Data from Application Competency Ratings and Application Assessment Items and Responses should not be
included in the same query because data will repeat if there is more than one assessment. The name of the
assessment should be pulled from the Application Assessment Ratings query subject.

Vacancy Application Application Assessment Application Assessment Application Competency Application Competency Application Application Competency Application Competency
Number Number Name Rating Series Rating Grade Competency Name Raw Score Maximum Raw Score
10000124 AJPYB-ZT1Y TestAQwithHire TestAQwithHire 0201 9 Customer Service 2 4
10000124 AJPYB-ZT1Y USA Hire 0201-9: Computer Adaptive TestAQwithHire 0201 9 Customer Service 2 4
Occupational Interaction
10000124 AJPYB-ZT1Y USA Hire 0201-9: Occupational Judgment  TestAQwithHire 0201 9 Customer Service 2 4
) Assessment (G2)
10000124 AJPYB-ZT1Y USA Hire 0201-9: Occupational Reasoning  TestAQwithHire 0201 9 Customer Service 2 4
Assessment
10000124 ABMRN-SOHX  TestAQwithHire TestAQwithHire 0201 9 Customer Service 225 4
10000124 ABMRN-S9HX  USA Hire 0201-9: Occupational Reading TestAfiwithHire 0201 9 Customer Service 225 4
10000124 ABMRN-SSHX  USAHire 0201-9: Occupational Reasoning  TestfQwithHire 0201 9 Customer Service 2.25 4
Assessment

10000124 ABMRN-SSHX  USA Hire 0201-9: Computer Adaptive Te
Occupational Interaction

10000124 AJPYB-ZT1Y USA Hire 0201-9: Occupational Reading

10000124 ABMRN-S9HX  USA Hire 0201-9: Occupational Judgment
Assessment (G2)

QwithHire 0201 9 Customer Service 2.25 4

TestAQwithHire 0201 9 Customer Service 2 4
stAQwithHire 0201 9 Customer Service 225 4

10000124 ABMRN-SSHX | TestAQwithHire lestAQwithHire 0201 9 Managing Human 25 4
Resources

10000124 AJPYB-ZT1Y USA Hire 0201-9: Computer Adaptive TestAQwithHire 0201 9 Managing Human 3 4
Occupational Interaction Resources

10000124 ABMRN-S9HX  USA Hire 0201-9: Occupational Reasoning  TestAQwithHire 0201 9 Managing Human 25 4
Assessment Resources

10000124 AIPYB-ZT1Y USA Hire 0201-9: Occupational Judgment  TestAQwithHire 0201 9 Managing Human 3 4
Assessment (G2) Resources

10000124 AJPYB-ZT1Y TestAQwithHire TestAQwithHire 0201 9 Managing Human 3 4
Resources

10000124 ABMRN-SSHX  USA Hire 0201-9: Computer Adaptive TestAQwithHire 0201 9 Managing Human 25 4
Occupational Interaction Resources

10000124 ABMRN-S9HX  USAHire 0201-9: Occupational Reading TestAQwithHire 0201 9 Managing Human 25 4
Resources

10000124 ABMRN-S9HX  USAHire 0201-9: Occupational Judgment  TestAQwithHire 0201 9 Managing Human 25 4
Assessment (G2) Resources

) 10000124 AIPYB-ZT1Y USA Hire 0201-9: Occupational Reading TestAQwithHire 020 9 Managing Human 3 4
Resources

10000124 AJPYB-ZT1Y USA Hire 0201-9: Occupational Reasoning _ TestAQwithHire 0201 9 Managing Human 3 4




Hurdles



Hurdle Data - Assessment Plan

When reporting on hurdle characteristics and assessment plan settings, use data from the Assessment
Packages area of HDW.

Azsessment Plan Hurdle Criteria Job Analysis m Checklist

~ 22 Hiring Data Warehouss
L Hurdle Settings
w T Presentation View d
» [J Announcaments @ Apply veterans' preference to hurdles
. (O Do not apply veterans’ preference to hurdles
> [ Applicants

> [ Applications
e Assessment Packages
> [ Aszessment Information
» [J Aszessment Package Information

~ =5 Assessment Scoring Information

» B8 Assessment Competencies Hurdle Name Hurdle Apply Veterans'
» Bf Assessment Competency Rating Combinations Number | Preference to Hurdles?
> B Assessment Item Scoring Procurement Analyst GS-1102-12TQ 1 Mo
~ B2 Assessment Plan Self AD 1 Mo
Y/ ! Y- 0 Frnint?
# Apply Veterans' Preference Points Prior to Cutpoint? TO GS-1109-12 GMA 1 No
# Apply Veterans' Preference to Hurdles?
self-Rated 1
abe Hurdle Mame
# Hurdle Number SME Resume Review-KSA 2 MNo




Hurdle Data - Criteria

When reporting on hurdle criteria only, use data from the Assessment Packages area of HDW.

~ ¥ Hiring Data Warehouse
~ B Presentation View
Cutpoint Method Cutpoint Value Used for Final Rating Proportional Weight Percentage Weight
> [ Announcements

ic Hurdle Score Cutpoint 85 (o000 O 7 0.000%
> [3 Applicants fssessment Plan Hurdle Criteria Job Ana

> [ Applications None . 0 4 1 100.0%
~ P Assessment Packages - Hurdle Criteria

> [J Assessment Information

- RakH C -0en1/ 0-
> [J Assessment Package Information Rati ngLom bO. 0801/1530-11 Cutpaint Method Cutpoint Value Used for Final Rating Proportional Weight Percantage Weight

~ 5 Assessment Scoring Information Hurdle Hurdle Score Cutpoint v 85 o000 O 1 /2 50.00%

> B8 Assessment Competencies Th e H u rd |e C rlte rl a Item S
> [ Assessment Competency Rating Combinations

> B Assessment Item Scoring prOVide information On the

Hurdle 2: New Hurdle
> B Assessment Plan

A characteristics of the hurdles i SR e

E Asse - - Rating Combo: 0801/1530-12
> B8 Assessment Screen-Outs
~ BH Hurdle Criteria themselves. Hurdle

abe Hurdle Cutpoint Method

Hurdle 1: Default Hurdle — " =] ] /2 50.00%

Hurdle 1: Default Hurdle Add veterans’ preference points to determine if the hurdle cutpoint is met

# Hurdle Cutpoint Value () "Float" eligible CR/CPS veterans to the next hurdle regardless of their score

Hurdle Percentage Weight
# ’ gel g Hurdle 2: New Hurdle 0801-11
ate Hurdle Proportional Weight 080112
abe Hurdle Rating Combination 1530-11
abe Used for Final Rating? 1530-12

abe Veterans Float Hurdle?

Data items are available to report on all aspects of hurdle criteria, including rating combination, cutpoint
method, cutpoint value, percentage and proportional weights, and indicators to designate if the hurdle is used
for the final rating and if veterans float.

. Hurdle Hurdle Hurdle Used for | Veterans
:';;:Es;t_l:f Hurdle Cutpoint Method Cutpoint Percentage | Proportional Final Float
Value Weight Weight Rating? Hurdle?
0601-14 Hurdle Score Cutpoint |80 75 75/100 Yes No
0318-9 Hurdle Score Cutpoint |90 50 1/2 Yes Yes

0561-6 Hurdle Score Cutpoint 85 50 1/2 Yes Yes



Hurdle Data - Assessment Rating Settings

When reporting on hurdle assessment rating settings, use data from the Assessment Packages area of the
Hiring Data Warehouse.

Qoo

™ ood

Hiring Data Warehouse
~ T Presentation View
» [0 Announcaements
» [ Applicants
» [ Applications
W Assessment Packages
» [ Assessment Information
> [ Assessment Package Information
v 3 Assessment Scoring Information
» B Assessment Competenciss
> [ Assessment Competency Rating Combinations
» E Assessment [tem Scoring
» H Assessment Plan
~ [ Assessment Rating Setlings
# Assessment Max Raw Scors
# Assessment Min Raw Score

# Assessment Pazsing Score

# Assessment Percentage Weight within Hurdle

abe Assessment Propertional Weight within Hurdle

Assessment Percentage Weight within Hurdle
16.7
25
50
16.7
20
100

334

Assessment Proportional Weight within Hurdle
0.167/1
0.25/1
1/2
13.36/80
20/100
2/2
0.334/1



Hurdle Data - Applicant List Filters

When reporting on hurdle filters used to create applicant lists, use data from the Applicants area of HDW.

v ¥ Hiring Data Warehouse
v B Presentation View
> [ Announcements
v 5 Applicants
> [ Applicant Infermation
~ 5 Applicant List Information
> B Applicant List
> B Applicant List Actions Filters

> doplcan st Appicans The Applicant List Hurdle Filters items can be combined with other
> B Applicant List Assessment Filters . . . . . . . ere .

> BB Applicant List Category Rating Fiters applicant list filter information, such as eligibility or location, to

» B Applicant List Certification Status Filters .

> 6 AEElicam List Eligibility Filters fU rther reflne report reSU|tS.

> B Applicant List Filters
> [ Applicant List Grade Filters
~ B Applicant List Hurdle Filters
# Applicant List Hurdle Filter Cutpoint
abe Applicant List Hurdle Filter Hurdle
abe Applicant List Hurdle Filter Hurdle Status
abe Applicant List Hurdle Filter Name
abe Applicant List Hurdle Filter Rating Combination
b

abe Applicant List Hurdle Filter Type

Data items are available to report on hurdle-related filters used to create applicant lists, including applicant list hurdle filter
name and type, the rating combination, the filter cutpoint, the specific hurdle used, and the applicant’s hurdle status.

Applicant List Hurdle Filter Name Applicant List Hurdle Filter Type Applicant List Hurdle Filter Rating Combination Applicant List Hurdle Filter Hurdle Applicant List Hurdle Filter Cutpoint Applicant List Hurdle Filter Hurdle Status
SME SI Cutpoint Hurdle Augmented Score 2210-13 Hurdle 1:Application Questionnaire & USA Hire Standard 85
GS-7 90 & Up Tullulah Hurdle Score 0561-7 Hurdle 1:Default Hurdle 90
fao Hurdle Score 0101-11 Hurdle 1:JAX 203808 90

GS-2210-13 Hurdle Status 2210-13 Hurdle 2:G5-2210-13 SME Resume Review Active



Hurdle Data - Certificate Filters

When reporting on hurdle filters used to create certificates, use data from the Certificates area of HDW.

~ B3 Hiring Data Warehouse
~ 75 Presentation View
» [J Announcements
> [3 Applicants
> [ Applications
» [3J Assessment Packages
~v 5 Certificates
~ 5 Certificate Filter Information

> [ Certificate Actions Filters

e e The Certificate Hurdle Filters items can be combined with other
8 ot certificate filter information, such as eligibility or location, to

& ot e e further refine report results.
~w [ Certificate Hurdle Filters

# Certificate Hurdle Filter Cutpoint

abe Certificate Hurdle Filter Hurdle

abe Certificate Hurdle Filter Hurdle Status

abe Certificate Hurdle Filter Name

abe Certificate Hurdle Filter Rating Combination

b

abe Certificate Hurdle Filter Type

Data items are available to report on hurdle-related filters used to create certificates, including the certificate hurdle filter
name and type, the rating combination, the cutpoint, and the specific hurdle used.

Certificate Hurdle Filter Mame Certificate Hurdle Filter Type Certificate Hurdle Filter Rating Combination Certificate Hurdle Filter Cutpoint Certificate Hurdle Filter Hurdle
Best Qualified G5-13 Cutoff Hurdle Score 0132-13 Q0 Hurdle 1:Default Hurdle
cutoff 95 Hurdle Score 1811-14 a5 Hurdle 1:Assessment Questionnaire

Best Qualified G5-14 Cutoff Hurdle Score 0132-14 90 Hurdle 1:Default Hurdle
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Announcement Questionnaire Data

When reporting on Announcement Questionnaire content only, use data from the Announcements area of
HDW.

goo

" oob

Hiring Data Warehouse
~ 15 Prasentation View
~ =5 Announcements
» [ Announcement Information
~ = Announcement Questionnaire Information
> HE Announcement [tems
» H Announcement Hesponse Options
» B Announcement Screen-0ut Rating Combinations
>

B Announcement Screen-Outs

Data items are available to report on all aspects of items and responses, including Section Name, Item Header,
Item Text, and response text for multiple choice items.

Section Title Announcement ltem Header Announcement [tem Text Announcement ltem Response Type Announcement lfiem Required?
Freferences Secret clearance Are vou willing to obtain a secret clearance? Radio Buttons - Yes/Mo Mo
Preferences  Willingness to Relocate Are you willing to relocate for this position without relocation expenses offered? Radio Buttons - Yes/No Yes

Preferences  Willingness to undergo security check Are vou willing to undergo a security check for this position? Radio Buitons - Yes/MNo Yes



Announcement Questionnaire Responses

When reporting on applicant responses to Announcement Questionnaire items, use data from the
Applications area of HDW.

~ B2 Hiring Data Warehouse
~w T Presentation View
> [0 Announcements
» [J Applicants
~ 5 Applications

v Prnosneement guestennare The Announcement Questionnaire Items and Responses includes

~ B Announcement Questionnaire Items and Responses

s Application Announcement Item Header the text of the items an applicant responded to as well as the
# Application Announcement Item ID . ,

sbe Application Announcement Item Required? a p p | |Ca nt S reS pO n Se.

abe Application Announcement Item Response Option

she Application Announcement Item Response Text

abe Application Anneuncement Item Response Type

/A Application Announcement Item Text

abe Application Announcement Item Used for Screen-Out?

abe Application Section Title

Application Number  Applicant Name | Application Section Title  Application Announcement Item Header Application Announcement Item Text Applicafion Announcement Item Response Text
ABSEV-2YVE Kapowski, Kelly  Preferences Secref clearance Are you willing to obtain a secref clearance? Yes
ABSEV-2YVE Kapowski, Kelly  Preferences Willingness to Relocate Are you willing to relocate for this posifien without relocation expenszes offered? Yes
ABSEV-2YVE Kapowski, Kelly  Preferences Willingness to undergo security check Are you willing to undergo a security check for this position? Yes
ABWVU-BKEH Decker, Dillon Preferences Secref clearance Are you willing to obfain a secref clearance? Yes
ABWWVU-BKEH Decker, Dillon Preferences Willingness to Relocate Are you willing to relocate for this position without relocation expenses offered? Yes
IAEP."\-".J'U—BKEH Decker. Dillon FPreferences Willingness to undergo security check Are you willing to undergo a security check for this position? Mo

Data from the Announcements and Applications area should not be included in the same query because data
will repeat (similar to when data from the Assessment Packages and Assessments areas are used together).
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Resources and Contacts

IBM Cognos Analytics User Guide
The official IBM user guide for Reporting via Cognos Analytics:
https://www.ibm.com/support/knowledgecenter/SSEP7) 11.0.0/com.ibm.swg.ba.cognos.ug cr rptstd.doc/ug cr rptstd.pdf?view=kc

USA Staffing Resource Center
Under the Reporting and Analytics section, you'll find presentations from previous workgroup sessions and other resources:
https://help.usastaffing.gov/ResourceCenter/index.php?title=USA_Staffing_Resource Center

Need Help?

If you are experiencing issues accessing Cognos or need help to create or troubleshoot a report, submit a Help Desk ticket through
USA Staffing. If you are unable to submit a Help Desk ticket, please contact us at USAStaffingData@opm.gov



https://www.ibm.com/support/knowledgecenter/SSEP7J_11.0.0/com.ibm.swg.ba.cognos.ug_cr_rptstd.doc/ug_cr_rptstd.pdf?view=kc
https://help.usastaffing.gov/ResourceCenter/index.php?title=USA_Staffing_Resource_Center
mailto:USAStaffingData@opm.gov
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